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= Please unmute your mic and turn your camera on and
say hello.

= Please ask questions.

Welcome

= One you have finished a practical activity either raise
your hand and keep it raised until | say lower them, or

just tell me.




Objectives

How to use Microsoft Excel 365
for Analysing and Summarising Data

Ccourse

Information + Duration

Delivery Style — demonstrations and practical’s




= Please fill iIn the Feedback form at the end of the
course http://feedback.training.cam.ac.uk/uis

Gen eral = Please ask questions
. (This is your course and | want you to get as much as
|nf0rmatIOn you can out of it)

= If you need assistance with the practical's let me know
and we can share desktops



http://feedback.training.cam.ac.uk/uis
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Course Material



Related Courses

www.linkedin.com/learning

COU rse www.training.cam.ac.uk

Information



https://www.linkedin.com/learning/search?keywords=excel&u=2963594
https://www.training.cam.ac.uk/search?selfTaught=on&course_type_facet_shown=true&scheduled=on&course_date_facet_shown=true&course_availability_facet_shown=&provider_facet_shown=&scrollPos=0&query=excel+365&_action_search=Search

All the exercises will work using the following

MICROSOFT
Microsoft

Excel 2016 Excel
2019

Wthh VerSiOn Thinking of upgrading?
Are you using?

Staff and students can download Office 365 for free
via this link

Get Office 365 ProPlus
on your personal devices...

[/
g .

—

All students, and staff from qualifying institutions: download Office 365 ProPlus
free on your personal devices to use while you are at Cambridge.
(Your login will expire 30 days after you leave the University)



https://help.uis.cam.ac.uk/service/collaboration/office365

Microsoft
Excel 365:

Analysing &
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Course Topics

Creating Charts
Chart Elements
Pivot Tables

Data Consolidation

Scenarios



Demo 1: Creating Charts
File ‘Charting_1’- ‘Sorting Text’ Spreadsheet
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A clustered column chart is used to compare values across a few categories,
E . l I l I ' Use it when the order of categories is not important.
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Practice Creating A Chart
File ‘Charting_1’use ‘Chart Data’ worksheet

Select range A3.G7
Create a Line Chart from recommended charts

Microsoft

Select range A3:G7 again

Ou tl 00 k 365 Create a Column Chart, move it into position and colour
It.
Creating Charts




Practice Adding Chart Elements
File ‘Charting_1’use ‘Chart Data’ worksheet

Using the Column Chart add some chart elements

Microsoft Choose a different design
OUtIOOk 305: Change the Colour
Creat| N g Ch artS Move an Embedded Chart onto its own sheet




Microsoft
Outlook 365:

Chart Elements

Demo — File ‘Charting 1’

Chart Blements

Fes

[] Axis Titles
Chart Title
|:| Data Labels
|:| Data Table
O O |:| Error Bars
Gridlines
Legend
|:| Trendline

Chart Design Format O

a{EANE~ 5

S| i Sidaded S

bl = dodiad = ddidad —
= Al S ddddad Sddddad -

[ s Tl



Microsoft
Outlook 365:

Chart Elements

Practice Adding Chart Elements
File ‘Charting_1’use ‘Chart 1’ worksheet

Add Chart Title and Axis Titles
Reposition Legend

Click the green + label

Choose Legend and move to top

Add some Data Labels

Toggle Grid Lines Off and On



Practice Adding Chart Elements
File ‘Charting_1’use ‘Chart 1’ worksheet

Add a Gradient Fill
Click on the Edge of Chart

\Y | Cros Oft Select the Format Tab

Fill dropdown

Outlook 365: Gradient Fil

Choose a pre-set

Chart Elements




Microsoft
Outlook 365:

Chart Elements

Practice Adding Chart Elements
File ‘Charting_1’use ‘Chart 1’ worksheet

Add a Linear Trendline for each city

Click into Chart

Select ‘Chart Design’ tab

Click on ‘Change Chart Type’ button
Choose a 2D chart

Click on + Chart Elements button
Add Trendline for each City



Microsoft
Outlook 365:

Chart Elements

Practice Adding Chart Elements
File ‘Charting_1’use ‘Chart 1’ worksheet

Create a Combo Chart

Select A3:G9

Click ‘Insert’

‘Recommended Charts’

Choose ‘Clustered Column’
Select ‘Chart Type’ button
Choose ‘Combo’

Set ‘Total Revenue’ to ‘Line’
Tick ‘Secondary Axis’ check box
Press OK



In Your Own Time

LinkedIn Learning - Excel: Charts in Depth

By Dennis Taylor

Microsoft includes:

Chart Essentials

Ou tl 0)0) k 365 Fine-Tune Your Charts

Adjust Chart Elements

Format Tab Options
Ch art EI emen tS Work With Popular Chart Types
Other Specialised Excel Charts
New Excel Chart Types
Change a Charts Data Source
Print and Share Charts
In-cell Chart Alternatives



https://www.linkedin.com/learning-login/share?account=2963594&forceAccount=false&redirect=https%3A%2F%2Fwww.linkedin.com%2Flearning%2Fexcel-charts-in-depth%3Ftrk%3Dshare_ent_url%26shareId%3DR8kWdhtmRdeS09yA3lQXng%253D%253D

Demo 2: Pivot Tables
File ‘PivotTables 2’— ‘Data Sheet Spreadsheet

1 | | |:||:I| —
Home Insert Draw D(j\ D J?

PiwvotTable Recommended Table

- - PivotTables
Microsoft
Outlook 365: . |

: PivotTable Fields v
P I V O t Tab I eS Choose fields to add to report: ‘{é}‘ -

Search jo
[] Mo

[ ] Menth

[ ] Salesperson

[] Make

L] Price

[] Age Grouping
[ ] Payment Method




Practice Pivot Tables
File ‘PivotTables 2’use ‘Data Sheet’ worksheet

Using Rows and Columns
Click into Data

Microsoft Insert Pivot Table
Outlook 365: Move:

‘Month’ into Columns

P|V0t Tab | es ‘Salesperson’ into Rows

‘Price’ into Values

Reverse ‘Month’ and ‘Salesperson’ and then change
back to how it was




Practice Pivot Tables
File ‘PivotTables 2’use ‘Data Sheet’ worksheet

Add additional Fields

M | Croso ft Drag ‘Age Grouping’ into Rows area
Move ‘Age Grouping’ out and replace with ‘Make’
Outlook 365:

Filters

Pivot Tables

Drag ‘Make’ into the Filter area
Filter using “Toyota’ and ‘VW’
Then Select Al

Drag ‘Make’ out of area

Try some others




Practice Pivot Tables
File ‘PivotTables 2’use ‘Data Sheet’ worksheet

Formatting A Pivot Table

Microsoft Click into Pivot Table
OUtI O()k 365 From the ‘Design’ Tab

Tick Banded Rows & Choose a Style

Pivot Tables




Practice Pivot Tables

File ‘PivotTables 2’use ‘Data Sheet’ worksheet

Slicers

Microsoft Click on PivotTable Analyze Tab
Insert Slicer

Ou tl 00 k 365 See how it works and delete it

Pivot Tables




Demo

— File ‘PivotTables 9’

ch

PivotTable Analyze Design

Microsoft
Outlook 365:

=

Insert

1]

=

Insert

Shicer Timeline

[E'.
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0 Filt
Pivot Tables —
Timeline Slicer o— 0 0
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o - | e
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Practice Pivot Tables
File ‘PivotTables 9’ use ‘PivotTable’ worksheet

Timeline Slicers

\Y | Croso ft Click on PivotTable Analyze Tab
Insert Timeline Slicer
Ou tl 00 k 365 Select the month Data you are interested in

Pivot Tables




Demo — File ‘PivotTable Features 2’

=

gs . x
Source Mame: Price

Custom Mame: |Sum of Price

Summarize Values By  Show Values 4s
T Moveto Report Filter

- Summarize value field by
M I ‘ r O S O t Il Move to Row Labels Choose the type of calculation that you want to use to summarize

=  plove to Column Labels data from the selected field

Sum
Count
Average
2% Remove Field Max
in
|__'ﬁ. Value Field Settings... Product v

_A

Outlook 365:

Pivot Tables S—
Formatting Values

Mumber

Mumber Format OK Cancel

Category:

General Sample
Mumber

Sum of Price
Accounting E -

Decimal places: |2

Date =
Time Symbol £

Percentage

Fraction Hegative numbers:

Scientific
Text £1,234.10

spedial -£1,234.10

Custom -£1,234,10




Practice Pivot Tables

File ‘PivotTable Features 2’ use ‘Sheet 1’ worksheet

Counting
M | Croso ft Click on ‘Sum of Price’ in ‘Values’ field
Click ‘Value Field Settings’
OUtIOOk 365 Change to ‘Count’

Pivot Tables




Practice Pivot Tables
File ‘PivotTable Features 2’ use ‘Sheet 1’ worksheet

Formatting Values

M | Croso ft Click on ‘Sum of Price’ in ‘Values’ field

Click ‘Value Field Settings’

Outlook 365: Change to ‘Sum'

Click on ‘Number Format button’

Piv Ot Tab | es Choose ‘Currency’




In Your Own Time

LinkedIn Learning - Excel: PivotTables in Depth

By Curt Frye

Microsoft includes:
Creating and Pivoting PivotTables
Ou 'tI 0]0) k 305: Summarising PivotTable Data
: Sorting and Filtering PivotTable Data
Pivot Tables Formatting PivotTables

Apply Conditional Formats to PivotTables
Creating and Formatting PivotCharts

Printing PivotTables

Manipulating PivotTables

Enabling and Adding Tables to the Data Model



https://www.linkedin.com/learning-login/share?account=2963594&forceAccount=false&redirect=https%3A%2F%2Fwww.linkedin.com%2Flearning%2Fexcel-pivottables-in-depth%3Ftrk%3Dshare_ent_url%26shareId%3DkS9H0BovSRqWYnDyrDWQ4g%253D%253D

Microsoft
Outlook 365:

Data
Consolidation

Demo 3: Data Consolidation
File ‘Consolidation 1’

Filtering Data_1.xlsx -

Formulas Data Review
=F £ Flash Fill He= Consolidate

Text to §
Columns C Data Validation ~  [Ffl Manage Data Model

E!: Remove Duplicates DE

Data Tools
Consolidate
Function:
Sum e
Reference:

“Wsersisimonandjot\Desktop\[Budget Restaurant.xlsx]Cafe'1SBSR5F511 |+

All references:

“Wsers\simonandjo\Desktop'[Budget Admin.xlsx]Admin'|SB58:5F511
“Wsers\simonandjo\Desktop'[Budget Gallery.xlsx]Gallery' ! SES&:5F511
“WsersisimonandjoiDesktop'[Budget Marketing.xlsx]5ales |5658:5F511

“Wsersisimonandjo\Desktop'\[Budget Restaurant.xlsy]Cafe’ !SB33:5F511

Use labels in

|:| Top row
[] Left column [“liCreate links to source data

Browse...

Close



Practice Data Consolidation
File ‘Consolidation 1’ use ‘Consolidation’ worksheet

Open: Consolidation_1.xlsx

MleOSOft Budget Admin.xIsx
Budget Gallery.xlsx
O ut I 00 k 365 : Budget Marketing.xIsx

Budget Restaurant.xlsx

Data
Consolidation Click into cell B7

Select the Data Tab / Consolidate button

On Consolidation_1.xIsx

Highlight B8:F11 in each of the 4 spreadsheets and

press Add
Tick Create Link & Press OK




In Your Own Time

LinkedIn Learning - Cert Prep: Excel Expert -
Microsoft Office Specialist for Office 2019 and Office
365

Microsoft |
By Jennifer McBee
Ou tl 00 k 365 Includes everything you would need to know to pass the
Excel Expert Exam. Worth watching even if you are not
Data considering taking the exam.
conso || d ation Section 4 Includes:

Summarize data from multiple ranges by using the
Consolidate feature



https://www.linkedin.com/learning-login/share?account=2963594&forceAccount=false&redirect=https%3A%2F%2Fwww.linkedin.com%2Flearning%2Fcert-prep-excel-expert-microsoft-office-specialist-for-office-2019-and-office-365%3Ftrk%3Dshare_ent_url%26shareId%3Dz3aFbuKQRpGLFDya48UOgw%253D%253D
https://www.linkedin.com/learning-login/share?account=2963594&forceAccount=false&redirect=https%3A%2F%2Fwww.linkedin.com%2Flearning%2Fcert-prep-excel-expert-microsoft-office-specialist-for-office-2019-and-office-365%2Fsummarize-data-from-multiple-ranges-by-using-the-consolidate-feature%3Ftrk%3Dshare_video_url%26shareId%3Dz3aFbuKQRpGLFDya48UOgw%253D%253D

Demo 4: Scenarios
File ‘Scenarios 1’

Filtering Data_1.xlsx -

Formulas Data Review

1
"

MI CrOSOft Whatilf Forecast

5 B

tI k 365- ?. 5'_42 Analysis ~  Sheet
: u O O . What-If |Forecast Group Forecast
Analysis ~| Sheet -

Assumptions

Scenarios

scenarnic Manager...

Required Growth 15%
h Cost of Goods 38% Scenario Manager ?
G te Overhead 12%
EDE' Seek... orpr:}rae verkeg ° = Scenarios:
Sales & Marketing 15% Worst Case Add..
Data Table... Jan  Feb |[BetCe Delete

Sales $210,000 $241,5 Edit...

Costs Merge...

Costof Goods 579,800 5917

Sales & Marketing 531,500 536,32

Capital Improvements 510&‘: Changing cells: | 5B54:5B57,5B8510,5C516

1

Total Costs $136,500 $256,9 COmment:

Profit/Loss $73,500 -$15,4

3

i

2

k]

7

3

3

(1]

1

2

2

4| Corporate Overheads 525,200 5289 summary...
&

6

T

8

9

0

1

2




Practice Scenarios
File ‘Scenarios_1’use ‘This Year’worksheet

Select Data Tab / What-if Analysis
Select ‘Scenario Manager’

Microsoft Click *Add’
Enter ‘Default Case’ in Scenario Name field
Ou tl 00 k 365 Click into ‘Changing Cells’ field
: Select B4:B7 & B10 & C16 (Orange values)
Scenarios Press OK
Press OK

Press Close




Practice Scenarios
File ‘Scenarios_1’use ‘This Year’worksheet

Select Data Tab / What-if Analysis
Select Scenario Manager

Microsoft Click ‘Add’

Enter ‘Worst Case’ in Scenario Name field

Outlook 365: Press ‘OK

. Type values as below:
Scenarios 10.05

2 0.45

30.20

40.20

5 16500

6 18000

Press ‘OK’

Press ‘Close’




Practice Scenarios
File ‘Scenarios_1’use ‘This Year’worksheet

Select Data Tab / What-if Analysis
Select Scenario Manager

Microsoft Click ‘Add’

Enter ‘Best Case’ in Scenario Name field

Outlook 365: Press ‘OK

. Type values as below:
Scenarios 10.25

2 0.25

3 0.05

4 0.25

541000

6 80000

Press ‘OK’

Press ‘Close’




Practice Scenarios

File ‘Scenarios_1’use ‘This Year’worksheet

Show the Scenario’s

Microsoft Select Data Tab / What-if Analysis

Select Scenario Manager

OUtIOOk 365 Click on a scenario

Press Show

Scenarios




In Your Own Time

LinkedIn Learning - Cert Prep: Excel Expert -
Microsoft Office Specialist for Office 2019 and Office
365

Microsoft By Jennifer McBee
Includes everything you would need to know to pass the
Ou tl 00 k 365 Excel Expert Exam. Worth watching even if you are not

considering taking the exam.

Scenarios

Section 4 Includes:
Use What-If Analysis Goal Seek and Scenario Manager



https://www.linkedin.com/learning-login/share?account=2963594&forceAccount=false&redirect=https%3A%2F%2Fwww.linkedin.com%2Flearning%2Fcert-prep-excel-expert-microsoft-office-specialist-for-office-2019-and-office-365%3Ftrk%3Dshare_ent_url%26shareId%3Dz3aFbuKQRpGLFDya48UOgw%253D%253D
https://www.linkedin.com/learning-login/share?account=2963594&forceAccount=false&redirect=https%3A%2F%2Fwww.linkedin.com%2Flearning%2Fcert-prep-excel-expert-microsoft-office-specialist-for-office-2019-and-office-365%2Fuse-what-if-analysis-goal-seek-and-scenario-manager%3Ftrk%3Dshare_video_url%26shareId%3Dz3aFbuKQRpGLFDya48UOgw%253D%253D

Thank you

Trainer: Simon Meaker ssm38@uis.cam.ac.uk
University Information Services — Training Services

service-desk@uis.cam.ac.uk
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